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Create a Search Folder 
 

 
A Search Folder is a virtual folder that provides a view of all email items that match specific search criteria. For example, 

the Unread Mail Search Folder enables you to view all unread messages in one folder, even though the messages might 

be saved in different folders across your mailbox. 

Note: Search Folders can’t conta n search results from mult ple Outlook Data F les (.pst). 

 

Create a new Search Folder 

You can create two different types of search folders. 

Create and use predefined Search Folders 

1. Select the Folder menu. 

2. In the New group, select New Search Folder. 

Keyboard shortcut    To create a new Search Folder, click Ctrl+Shift+P. 

3. From the Select a Search Folder list, click the Search Folder you want to add. Some of the predefined Search 

Folders are only available if you scroll down to the end of the list. 

4. If the predefined Search Folder has customization options, you'll see those options appear under Customize 

Search Folder. For example, if you select Mail with specific words, under Customize Search Folder, specify 

the words to use. 

Note: Search Folders use prefix matching searches when you type specific words to include in the search. For 

example, if you type "rain" in the word list, the Search Folder will include messages that contain the word "rain" 

and the word "rainy." The Search Folder will not contain messages that include the words "brain" or "grain." 

5. If you have multiple accounts in Outlook, you can specify which account to search. Use the Search mail in box to 

pick the email account you want to search. then select OK. 

Create a customized Search Folder 

1. Select the Folder menu. 

2. In the New group, select New Search Folder. 

Keyboard shortcut    To create a Search Folder, click Ctrl+Shift+P. 

3. From the Select a Search Folder list, scroll down to the bottom and then click Create a custom Search Folder. 
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4. Under Customize Search Folder, click Choose. 

5. Type a name for your custom Search Folder. 

 

6. Click Criteria, and then select the options that you want. 

▪ The Messages tab contains criteria on the message content or properties, such as sender, keywords, or 

recipients. 
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▪ The More Choices tab contains criteria on other message conditions, such as importance, flags, 

attachments, or categorization. 

▪ The Advanced tab enables you to make detailed criteria. Under Define more criteria, click Field, click 

the type of criterion that you want, and then click the specific criterion from the list. Then in 

the Condition box and the Value box, click the options that you want, and then click Add to List. Repeat 

for each criterion that you want to add to this search folder, and then click OK. 

7. Click Browse, select the folders that you want to be searched. 

8. Click OK to close each open dialog box. 

Delete a Search Folder 

If you no longer need a Search Folder, you can delete it. A Search Folder is a virtual folder. Deleting a Search Folder from 

the folder list doesn't delete the messages displayed in the folder. If you want to delete all messages within a Search 

Folder, open the Search Folder, select all of the messages, then click Delete on your keyboard. 

To delete a search folder, use the following steps. 

1. In the Folder List, select the down arrow next to the word Search Folders if needed to expand your list of Search 

Folders. 

2. Right-click the Search Folder you want to delete, and choose Delete Folder. 

Important: Deleting a Search Folder doesn't delete any messages. Deleting a folder that's not a Search Folder will 

delete both the folder and the messages inside the folder. 

 
  

Find people and contacts 
 

 
There are several different ways you can search for a contact. You can use the Search People box on the ribbon in any 

Outlook folder, search while composing a new message or meeting, or search in Outlook's People pane (formerly known 

as the Contacts folder). 



  

 

            Updated 01.22.2021  ISD Service Desk 714.509.4457   4 of 18    

Microsoft Resources 

Outlook 
 

 
 

Outlook - Manage and organize: Search Feature 

Search for a contact using the Search People box on the ribbon 

This is the quickest and easiest way to find a contact. Position your cursor in the Search People box, then start typing the 

first few letters of the person's first name or email address. As you type, Outlook will continually refine the search. For 

example, if you type the letter t, Outlook will return matches such as Tony, Teresa, and Tanya. If you type ta, Outlook will 

further refine that list to Tanya. 

Search for a contact while composing a new message 

When you select the To, Cc, or Bcc buttons in a new message, Outlook will display your default address book. If you have 

an Exchange or Microsoft 365 account, that's your organization's Global Address List. If you're using a POP or IMAP 

account, you'll see your Contacts folder. 

If you have multiple contacts folders or address books, you can use the drop-down under Address Book to choose among 

them. When you do, you'll see an alphabetized list of contacts, sorted by name. 

To search, type part of the contact's name in the Search box and then select Go. You can select the More columns radio 

button to search by other fields, including department, phone, and location. Once Outlook returns a list of contacts, 

double-click the one you want to add the contact to the To box, or select the contact and then click To, Cc, or Bcc to add 

the contact to the respective boxes. 

Search for a contact in the People pane 

1. Choose People at the bottom of the screen. 

 

2. Above your contacts list, place your cursor in the Search Contacts box. 

 

Note: The Search Contacts box at the top of your list of contacts is different than the Search People box, which 

is in the top-right corner of the Outlook ribbon. The Search People box only searches on names and email 

addresses. The Search Contacts box searches phone numbers, addresses, company names, and more. 
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3. Type the person’s name or other information—like a phone number or company name—you want to search for. 

Tip: You can search for complete or partial information. If you're searching for someone named Chris Preston, for 

example, you can type the full name or “pre,” wh ch represents the f rst three characters of the last name. 

4. Outlook displays your search results in card form, showing the contact photo, email address, business or home 

address, and phone numbers. Choose the person you want from the search results. 

Note: As you type, Outlook refines its search. For example, if you type the letter J, Outlook will return results that 

contain John, James, Jack, Julian, and Julie. If you type Jul, Outlook will return results that include Julian and 

Julie in any field, including company name, email address, and physical address. 

Narrow your search 

Getting too many results when you search for complete or partial information? Consider further refining your search. 

When you choose the Search People box on the People tab, the Search Tools tab appears. 

Tip: You can also press Ctrl+E to open the Search Tools tab. 

 

There are many options available, including the following groups of options on the Search Tools tab, to help narrow your 

search. 

▪ Scope    Change the folders you want to search in. 
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▪ Refine    Search for people who have phone numbers or other specific types of information in their contact 

information. 

▪ Options    Use previous searches or change advanced search options. 

 
  

Search and filter messages 
 

 
Search is a powerful tool to help find email messages anywhere in Outlook. 

Search email 

1. Select the search bar, located above the Outlook ribbon.  

2. Type a name, subject, or phrase which is included in the email message that you want to find. 

Refine your search results 

1. Select the search bar and type a name or subject. 

2. Select an option to refine or widen your search: All Mailboxes, Current Mailbox, Current Folder, Subfolder, 

or All Outlook Items. 

3. You can also select a category within the Refine group to further filter your search results: 

▪ From – only shows results from a specific person. 

▪ Subject - only shows results based on the subject. 

▪ Has Attachment – only shows emails that have attachments. 

▪ Categorized – only shows results that have a specific category assigned to them. 

▪ This Week - searches by when the email message was received: Today, Yesterday, This Week, Last 

Week, This Month, Last Month, This Year, or Last Year. 

▪ Sent To – searches messages Sent to You, Not Sent Directly to You, or Sent to Another Recipient. 

▪ Unread – only shows unread messages. 

▪ Flagged - only shows messages flagged by you. 

▪ Important - only shows emails marked as Important. 

▪ More - filters your results based on more advanced criteria, such as Cc or Sensitivity. 

4. Select Recent Searches to run recent searches again. 

Note: Outlook saves only the recent search query, not the results. 

5. Select Close Search to close the Search tab. 

 

Cl ck to watch the “Search and f lter ema l” v deo. 

 
 
 
 

https://www.microsoft.com/en-us/videoplayer/embed/RWfvNA?pid=ocpVideo0-innerdiv-oneplayer&postJsllMsg=true&maskLevel=20&market=en-us
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Find a message or item with Instant Search 
 

 

Find a message 

1. In the navigation bar, near the bottom of the screen, click Mail. 

 

If you don't see this, "Compact Navigation" might be turned on, so you'll see icons instead, like this: 

 

Or, in addition to "Compact Navigation" being on, the folder pane might be minimized, so the icons are arranged 

vertically. You can expand the folder pane by clicking the Minimize/Expand button, as shown here: 
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2. F nd the search box. It’s at the top of your messages, as shown here: 

 

3. To find a word that you know is in a message, or a message from a particular person, type the word or person's 

name (you can use first, last, and partial names) in the search box. Messages that contain the word or name you 

specified appear with the search text highlighted in the results. 
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4. You can narrow your results even further by changing your search. Here are some common examples: 

▪ Type "expense reports" (including the quotes) to find messages containing the exact phrase "expense 

reports." 

▪ Type expense AND report ("AND" needs to be in all caps) to find messages containing both the word 

expense and the word report, but not necessarily in that order. You can also use "OR." 

▪ Type expense NOT report ("NOT" needs to be in all caps) to find messages containing the word 

expense but not the word report. 

5. NOTE: Searching will only find items if you search for an entire word, or the beginning of a word; if you search for 

the middle or end of a word you will not find the item. For example, if the message subject contains "Email about 

Office365", the following searches will NOT find that item: 

▪ "mail" -- because this is the end of the word "email" 

▪ "365" -- because this is the end of the word "Office365" 

▪ "ice" -- because this is in the middle of the word "Office365" 

6. When you’re f n shed, you can clear the search by clicking the  in the search box. 

Narrow your search results 

If you can’t f nd what you’re look ng for, use the search tools on the r bbon to narrow down your search. When you cl ck 

the search box, you can select a scope option on the left side of the ribbon. Once you decide your scope, you can then 

refine your search further by selecting an option such as the subject line or the sender. 

Scope (where to search): Here you can choose to search in specific folders, such as all your mailboxes, or just the 

current folder you’ve selected, wh ch  s your Inbox most of the time. 

 

Refine (what to search for): When you’ve selected your scope, you can add other cr ter a  n the Refine group. When you 

select an option, Outlook adds a special script to the search box to limit its search. 

javascript:
javascript:
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Let’s take a look at the opt ons. 

▪ From: filters your search results to only show messages sent by a specific person. For example, you can search 

for all the messages sent by Sara. 

▪ Subject: filters your search results based on the subject line of the email. For example, you can search for all the 

messages that have the keyword “report” in the subject line. 

▪ Has Attachments: gives you all the messages that contain an attachment. 

▪ Categorized: choose a category to see all the messages that you’ve flagged w th a spec f c category. 

▪ This Week: on the drop-down menu, choose a time frame to narrow your search results based on the time you 

received a message. 

▪ Sent To: on the drop-down menu, choose an option to filter the results based on the email recipients. For 

example the messages that you were CCed on, or the ones that were sent to a specific person. 

▪ Unread: br ngs up all the unread messages  n the folder that you’ve selected. 

▪ Flagged: brings up messages that you flagged to follow up. 

▪ Important: shows all the messages that were marked with high importance. 

▪ More: choose an option on the menu to further narrow down your search results. For example you can filter by 

sensitivity or message size. 

Remember that you can mix and match these options. 

Here's an example: You can search for all the messages from Sara that you received last month, with the 

keyword “report”  n the subject l ne. 

To set up a search for this example: 

1. Make sure Inbox is selected, then click in the Search box. 

2. Select Subfolders in the Scope group. 

3. Click From and type Sara to replace the highlighted text in the search box. 

4. Click Subject and type report to replace the highlighted text in the search box. 

5. From the drop-down menu next to This Week, select Last Month. 
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Use Advanced Find 

Getting too many results? Or are you just not finding what you want? 

1. Click in the search box. 

2. On the Search tab, click Search Tools > Advanced Find. 

 

In the Advanced Find box, you can specify much more complex criteria and even search in your calendar, contacts list, 

notes, and tasks. 

1. Click the Advanced tab. 

2. Under Define more criteria, click the Field button and then click All Mail Fields. You'll see a menu of fields you 

can search on, such as From, To, Received, Subject, and dozens more. 
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3. Start by choosing a field, then choose a condition and a value to test. For example: 

From/ Contains/ Katie will search for messages from someone whose name includes "Katie." Notice we're 

using contains as the condition instead of is (exactly) so that we don't have to find an exact match. So if Katie's email 

name is "Katie Jordan," From/is (exactly)/Katie won't work because we'd need to specify Katie's full name, Katie Jordan, 

to get an exact match. That's where contains comes in handy as a condition. 

4. Add as many additional conditions as you need or want to test. We'll add three more: 

From | Contains | Katie will search for messages from someone whose name includes "Katie." Notice we're 

using contains as the condition instead of is (exactly) so that we don't have to find an exact match. So if Katie's email 

name is "Katie Jordan," From | is (exactly) |Katie won't work because we'd need to specify Katie's full name, Katie 

Jordan, to get an exact match. That's where contains comes in handy as a condition. 

Then, let's say you add these as well: 

▪ Received | between | 5/01/13 and 5/31/13 

▪ Message | contains | budget 

▪ To | contains | Rob 
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Now, Outlook searches for messages from someone with "Katie" in her name that arrived in the inbox in May, 2013, with 

"budget" in the message body, and (in addition to you) were also sent to someone with "Rob" in his name. Here's a 

zoomed look at the list of the four criteria we added. 

 

Finally, click Find Now to run the search. 

 

Remove the limit on the number of search results 

If the thought of more than 250 results doesn't scare you off, you can bypass that limit: 

1. Click File > Options > Search. 

2. Under Results, clear the Improve search speed by limiting the number of results shown check box. 
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Learn to narrow your search criteria for better searches 
 

 
You can type a number of phrases in the Search box at the top of the Outlook message list. In addition to searching for 

different words and phrases, you can use various operators, punctuation and keywords to narrow your search results. 

The most basic way to search is to simply type in a word or phrase. 

NOTE: Outlook uses what's called prefix matching when searching. So if you type ray into the Search box, 

Outlook will return messages that contain ray, Ray, Raymond, and rays, but not disarray or tray. Also, the search 

treats numbers that are connected to words (no spaces between the word and the number) as part of the word. 

Searching for "365" will NOT find messages that contain "Office365". 

Search basics 

▪ When you type words into the Search box, Outlook scans both email messages and many types of attachments 

for that word or phrase. For example, if you search for "project" either with or without quotes, Outlook will return all 

messages with the word project, projects, projector, projecting, etc. anywhere in the sender name, subject, 

message body, or attachments. 

▪ When you type in an email address, for example chery.parsons64@yahoo.com, Outlook returns all email 

messages that contain that email address anywhere in the subject, message body, or many types of attachments 

as well as messages from that email address. To limit your search results to emails from an email address, type 

from:cheryl.parsons64@yahoo.com in the search box. 

Use Outlook's built-in search filters 

Outlook provides you with a number of built-in search filters. To use the built-in filters, click in the Search box. The Outlook 

ribbon will change to show the Search tab. Use any of the options in the Refine group to refine your search results. 

 

Search reference tables 

The following table shows you some examples of searches you might find useful. In addition to these examples, you can 

use AND, NOT, OR, <, >, =, and other operators to refine your search. Operators should be typed in uppercase letters. 

Type this To find this 

bob Items containing bob, bobbinbobby, BOBBY, BoBby, or any other combination of 

uppercase and lowercase letters. Instant Search is not case sensitive. This will NOT find 

items containing abcBOBdef, or 123bob. 
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Type this To find this 

bob moore Items containing bob, along with all of the variations listed in the previous row, or moore, 

along with any other words that contain moore, but not necessarily in that order. 

bobby AND moore Items containing both bobby and moore, but not necessarily in that order. Note that 

logical operators such as AND, NOT, and OR must be in uppercase letters. 

bobby NOT moore Items containing bobby, along with all variations listed in the first row of the table, but 

not moore. 

bobby OR moore Items containing bobby, along with all variations listed in the first row of the table, moore, 

or both. 

"bob" Items containing the exact phrase bob and not the variations such as bobby or bobbin. 

To search for an exact string, you must use quotation marks. 

from:"bobby moore" Items sent from bobby moore. Note the use of double quotes so that the search results 

match the exact phrase within the quotes. 

You can also type from: and then the first few letters of a contact's name and Outlook 

will suggest a list of contacts for you to select. 

from:"bobby moore" about:”status 

report” 

Items sent from bobby moore where status report appears in the subject line, body, or 

attachment contents. Note the use of double quotes so that the search results match the 

exact phrase within the quotes. 

hasattachment:yes Items that have attachments. You can also use hasattachment:true to get the same 

results. 

attachments:presentation.pptx Items that have attachments named presentation.pptx or an attachment that 

contains presentation.pptx within its contents. 

subject:"bobby moore" Items whose subject contains the phrase bobby moore. 

cc:"bobby moore" Items in which the display name bobby moore is on the Cc line. 

cc:bobbymoore@contoso.com Items in which the e-mail address bobbymoore@contoso.com is on the Cc line. 

bcc:bobby Items in which bobbyy is on the Bcc line. 

category:red Items that contain a category name that includes the word red. For example "Red 

category" or "Redo" or "Redundant." 

messagesize:<10 KB Items whose size is less than 10 kilobytes. Note the use of the "less than" comparison 

operator (<). 

messagesize:>5 MB Items whose size is larger than 5 megabytes. Note the use of the "greater than" 

comparison operator (>). 

received:=1/1/2016 Items that arrived on 1/1/2016. Note the use of the "equals" comparison operator (=). 
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Type this To find this 

Note: Support for specifying custom dates via the Expanded Search drop-down is 

missing from some builds of Outlook for Windows. Users can still manually enter dates in 

the main search box. This is fixed in builds 16.0.12126.10000 and later. 

received:yesterday Items that arrived yesterday. Instant Search also recognizes the follow date values: 

▪ Relative dates:    For example, today, tomorrow, yesterday 

▪ Multi-word relative dates:    For example, this week, next month, last 

week, past month, coming year 

▪ Days:     Sunday, Monday ... Saturday 

▪ Months:     January, February ... December 

received:last week Items that arrived last week. Note that if you run this query again a month from now you 

will obtain different results because it is a time relative query. 

due:last week Items that are flagged for follow up a due date. 

messagesize:tiny Items whose size is less than 10 kilobytes 

messagesize:small Items whose size is between 10 and 25 kilobytes 

messagesize:medium Items whose size is between 25 and 100 kilobytes 

messagesize:large Items whose size is between 100 and 500 kilobytes 

messagesize:verylarge Items whose size is between 500 kilobytes and 1 megabyte 

followupflag:follow up Items that are flagged using the Follow Up flag. 

messagesize:enormous Items whose size is larger than 5 megabytes 

hasflag:true Items that are flagged for follow up. 

from:bobby (received:1/7/17 OR 

received:1/8/17) 

Items from bobby that arrived on either 1/7/17 or 1/8/17. Note the use of parentheses to 

group the dates. 

received>=10/1/16 AND 

received<=10/5/16 

Items that arrived between 10/1/16 and 10/5/16.  

Note: For received ranges, do not use a colon.  

received>10/1/16 AND 

received<10/5/16 

Items that arrived after 10/1/16 but before 10/5/16. 

Note: For received ranges, do not use a colon.  

sent: yesterday Returns all items sent yesterday (by anyone). This search will return items you sent to 

others and items others sent to you. 

to:bobby Items that you sent to bobby when you are searching in the Sent Items folder. 

read:no Items that have not been read. You can also use read:false to get the same results. 

subject:status received:May Items received from anyone during the month of May (any year) where the subject 

contains status. 
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Calendar Searches 

The following searches will only return the proper results when run from a Calendar folder. 

Type this To find this 

startdate:next week subject:status  Calendar items next week where the subject contains status. 

is:recurring Calendar items that are recurring. 

organizer:bobby Calendar items where bobby is the organizer. 

Contact Searches 

The following searches will only return the proper results when run from a Contacts folder. 

Type this To find this 

firstname:bobby Contacts that contain bobby in the First Name field. 

lastname:moore Contacts that contain moore in the Last Name field. 

nickname:bobby Contacts that contain bobby in the Nickname field. 

jobtitle:physician Contacts that contain physician in the Job Title field. 

businessphone:555-0100 Contacts that contain 555-0100 in the Business Phone field. 

homephone:555-0100 Contacts that contain 555-0100 in the Home Phone field. 

mobilephone:555-0100 Contacts that contain 555-0100 in the Mobile Phone field. 

businessfax:555-0100 Contacts that contain 555-0100 in the Business Fax field. 

businessaddress:(4567 Main St., 

Buffalo, NY 98052) 

Contacts that contain 4567 Main St., Buffalo, NY 98052 in the Business 

Address field. Note the use of parentheses to enclose the address. 

homeaddress:(4567 Main St., Buffalo, 

NY 98052) 

Contacts that contain 4567 Main St., Buffalo, NY 98052 in the Home 

Address field. Note the use of parentheses to enclose the address. 

businesscity:buffalo Contacts that contain buffalo in the Business City field. 

businesspostalcode:98052 Contacts that contain 98052 in the Business Postal Code field. 

street:(4567 Main St) Contacts that contain 4567 Main St in the Business Address Street field. 

Note the use of parentheses to enclose the address. 

homestreet:(4567 Main St) Contacts that contain 4567 Main St in the Home Address Street field. Note 

the use of parentheses to enclose the address. 

birthday:6/4/1960 Contacts that contain 6/4/1960 in the Birthday field. 

webpage:www.contoso.com Contacts that contain the URL www.contoso.com in the Web Page Address 

field. 
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Open and find items in an archive Outlook Data File (.pst) 
 

 
Open an Outlook data file 

In order for Outlook to search a Personal Folders file for a specific word or phrase or sender, the file must be open in 

Outlook. 

1. In Outlook on your desktop (Outlook 2016, Outlook 2013, Outlook 2010), choose File > Open and Export > 

Open Outlook Data File. 

2. Choose the Outlook data file you want to open. 

 

3. Expand the top level of the Outlook data file in the Outlook Navigation pane to see the subfolders in the file. Click 

each subfolder to see the contents. 

 

4. To search for a specific email, use Outlook's built-in search tools. 

5. If you want to import your archived items back into your Inbox, follow the instructions for importing a .pst file. 

Where is my .PST file? 

In Outlook 2016, Outlook 2013, Outlook 2010, new Outlook data files are, by default, saved in the following locations: 

▪ Windows Vista, Windows 7, 8, and 10    drive:\Users\user\Documents\Outlook Files\archive.ps 

 

For more information, please refer to the Microsoft training resource page HERE 

https://support.microsoft.com/en-us/office/import-email-contacts-and-calendar-from-an-outlook-pst-file-431a8e9a-f99f-4d5f-ae48-ded54b3440ac
https://support.microsoft.com/en-us/office/video-what-is-microsoft-teams-422bf3aa-9ae8-46f1-83a2-e65720e1a34d?wt.mc_id=otc_microsoft_teams

